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1. Introduction 

1.1 About GalleryData 
GalleryData is a member of the Label Gallery family, 
which forms a new generation of program equipment for 
designing and printing labels. GalleryData is a simple 
program, designed for managing databases. Program 
allows elaboration of tables, changing structures, renewal 
of indexes, automatic filling and deleting data. 

Program supports Paradox, dBase, Access and tables of 
ASCII type. You can also access other database types via 
ODBC or BDE interfaces. 

GalleryData is a standard 32-bit Windows application. 

1.2 About this manual 
User’s guide compounds three chapters: 

• Installation 

• Introduction  

• Technical documentation 

 
Introduction 

Chapter introduces commands of GalleryData and is 
designated to users, which want to confirm the 
understanding of single program’s commands. 
Technical documentation 

Chapter introduces different possibilities of using 
GalleryData program, review of parameters and 
explanation of descriptive files. 
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Samples 

A few samples how to use GalleryData. 

1.2.1 Conventions used in this Manual 

Text that appears in bold letters refers to the names of the 
menus, buttons and other 'clickable' things like OK 
button. 

Text that appears in italic refers to the options and 
confirming actions - like Read only. 

Text enclosed in brackets refers to keys from the PC 
keyboard like <Enter>. 

Variables are enclosed in square brackets like [variable-
a]. 
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2. Reference 

2.1 Overview 
This chapter covers the starting of GalleryData program, 
arranging data in the active table and the presentation of 
program’s commands. 

2.2 Start 
Double clicking on the program's icon starts GalleryData 
program. In the dialog box Properties can be added a 
command line, which provides the execution of particular 
actions (see chapter Technical documentation/Command 
line setup). Databases, which have been opened at the 
end, load themselves automatically when program is 
started again.  

 
GalleryData main window 
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2.3 Arrangement in the active table 
Data in the active table can be arranged only when a table 
is in arranging condition (see command View / Edit). 
Document’s condition is shown in the status line. With 
cursor keys you can move between fields in the table. 
Active field is shaded. 

Whenever you want to change data, you simply write in 
the desired text. 

Entire record can be deleted by pressing a keyboard 
shortcut <CTRL> + <Delete>. 

Use <INSERT> key or press <ARROW DOWN> key on 
the last field to insert a new field. 

2.4 File menu 

2.4.1 New  

Opens a new, untitled table. 
By clicking this command you will open a Table type 
dialog box. There you can select your desired table type. 

 
Table type dialog box 

Supported table types are: 

- Paradox 3.5, 4, 5, 7 

- Visual dBase 7 

- dBase IV, dBase III+ 
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Fields tab 

 
New table dialog box - Fields tab 

For each field is necessary to enter name, type, length and 
index. 
Name of the field must be compatible with conventions, 
valid for Paradox/DBASE tables.  

Field type must suit available types: 

• A or C - alphanumeric field 

• N - number in signature with a floating comma 

• S - integers in range -32768 to 32767 

• I - long integers. Paradox long integer fields are 
32-bit signed integers that contain whole 
numbers (non-fractional) with complete 
accuracy in the range -2147483648 to 
2147483647 (plus or minus 2 to the 31st power). 
Long integer fields require more space to store 
than short fields. 

• L - logical value TRUE, FALSE 

• D - date  

• T - time 

• @ - timestamp 
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A click on the right button in the Type field or pressing 
the Space key shows a menu of types. There you can 
choose the desired type of data. 
Field Index in the table is used for defining the primary 
index. The basic key can contain only successive fields 
together with the first field in the record. Double click on 
the Index field or press <space> to toggle selection of 
indexes for the field. For dBASE tables the Index field is 
replaced by Dec field in which you can specify number of 
decimal places for the numeric field. 
Option Table language selects language driver used for 
the table. Default language driver is set in the BDE 
Administrator. 

Use <Insert> or press <Arrow down> key on last field to 
insert new field. 

Use <CTRL> + <Delete> key to delete field. 

Press <F2> key to edit current field. 

<Home> and <End> keys are used for navigation to 
first/last field in the record or beginning/end of the fields, 
if you are in edit mode. 
Use Borrow button to copy the database structure of an 
existing database. Only structure of the existing table will 
be transferred. Result will be an empty database with 
copied data structure. 
Use Save As button to save the current database to 
another filename. Both, structure and data, are saved to 
the new file. This functionality is the same as command 
Save As in File menu. 

Indexes tab 

On the Index tab of the New table dialog box, you can 
add or modify the indexes for your table. 

Note, if you have no fields indexed in Paradox type of the 
database, GalleryData will report an error when you want 
to access this tab. First define a primary index in the 
Fields tab, then return here. This is not necessary for 
dBase databases. 
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New table dialog box - Index tab 

You can add new index file by clicking on the Add 
button or modify existing index by clicking on the 
Modify button. This opens the Modify index dialog box, 
where you can set the index files. 

 
Modify index dialog box 

Dialog box includes list of fields in the table (on the left 
side) and fields that are indexed (on the right side). Select 
the field you want to create index for and click the button 

. The field name will be transferred to the Indexed 
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fields memo box. Set additional option described below 
and index for selected field can be generated. 

Check Unique to create unique index. What this means is 
that only one record with the same value in this field will 
be used in the whole database. The field values can not be 
duplicated. 
Check Case sensitive to create case sensitive index. It this 
option is enabled, "Mary", "MARY", "MaRy" or "mary" 
will all be different field values. 
Check Descending to create descending index. If you are 
using index on some database field, the default setting is 
to order values in ascending order. Select this option, if 
you want a reversed – descending order. 

Note, you can use only one field for index generation or 
more of them to create a combined index. 

Program will create a new index, if the entered name of 
index differs from other indexes. Clicking on the Save 
button, you save all changes in the current index.  
Notes for Paradox tables: 

In order to design secondary indexes, table must have 
defined primary index. One of the fields has to be set as 
primary index. 

If only one field is selected for index and case-sensitive 
selection is checked then the field name will be used for 
index name. This feature allows user to create both case 
sensitive and case insensitive index on single field in 
table. 
Notes for dBase tables: 

Only single field indexes are allowed for dBase tables. 

2.4.2 Open 

Open a previously saved table. This command supports 
only files of Paradox, ASCII, dBase and MS Access 
types. The appearance of the dialog box is same like all 
dialog boxes for opening documents in standard 
Windows applications. 
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When you choose MS Access file type, additional dialog 
box will be displayed allowing you to select a proper 
table within MS Access database. 

If you try to open a new formatted text file (.TXT) or file 
with comma-separated-values .CSV) a Text File Wizard 
will help you define the structure of the file and display 
the values in GalleryData. Setting will be stored for the 
next time, defining the structure of text files is necessary 
to be done only once. 

2.4.3 Text File Wizard 

When the input database file is a plain ASCII text file or 
formatted CSV (Comma Separated Values), Text File 
Wizard will be started and it will guide you thru quick 
and easy steps of text data acquirement. The main 
difference between real database and text file is in their 
data structure information. Databases include the whole 
information about their fields (names, data format, 
length) and can be automatically used with GalleryData. 
Text files, on the other hand, do not have stored such 
information and you will have to tell GalleryData how 
the data is encoded. 

Choosing Data Type 

Before you can use text file, you will have to define its 
data structure. Fields can be delimited by some sort of a 
separator (tab, semicolon, comma or some entirely user-
defined separator) or can be of a fixed length. 
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Database Wizard –Choosing Data Type 

Choose Delimited , if you know that data fields are 
separated with some special character. File preview at the 
bottom of the dialog box can be helpful, if you do not 
know exactly how the data is organized. 
Choose Fixed  if you know, that you data fields always 
occupy the same number of characters. 

Start import at row  option is useful, when you do not 
want to import some rows at the top of the file. Most 
usual situation, when you would want to use this option is 
when text file contains some header on top of actual data 
fields. 
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Setting the fields 

 
Database Wizard –Setting separator and delimiter 

In the second step of the Text File Wizard you have to set 
the fields in the text file. If you have selected Delimited  
in the previous step, choose the appropriate separator 
here. The ones that are usually used with text files are 
already pre-defined. But if you require some other, there 
is an option to use a custom-defined one. 

You can also select the Delimiter character that is used 
when separator character is used in the text field itself. 
The delimiter should be used to enclose such field. Text 
between two delimiter characters is treated as one field 
although it contains the field separator character. 

The data preview in the bottom part of the dialog box will 
let you know if your choice of a separator character is a 
correct one. Fields will be separated with vertical lines, if 
a separator is valid. 



Chapter 2: Reference  
 
 

2-10 GalleryData User's Manual 

 
Database Wizard –Setting column breaks 

If you have selected that your data is formatted with fixed 
widths, the second step of the Wizard will be slightly 
different. Instead of selecting character for field 
separation, you will have to define field widths. The 
Wizard makes is as simple as possible. Use a mouse and 
draw a vertical line to the start positions of the fields. 
Lines will indicate where the new field starts. 

Formatting the fields 
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Database Wizard –Formatting the fields 

In this step of the Wizard you can review the fields' 
names and lengths and modify them, if necessary. You 
will probably use friendly field names, so you can 
distinguish between them more easily in Label Gallery. 

When you are finished with Text File Wizard, the 
structure information of the used text file is stored to a 
separate file with a extension of .SCH (Scheme File). If 
you will try to use the same text file some other time on a 
different label, you will be spared all efforts of structure 
creating. SCH file will be automatically used and Text 
File Wizard will be skipped entirely. 

2.4.4 Open Alias 

Opens database from alias defined either in BDE or 
ODBC Manager. 

 
Select table dialog box 

First select the alias name and then the table name. 

When you click OK, selected table is opened in 
GalleryData. 

2.4.5 Close 

Closes currently selected database file. 

2.4.6 Save as  

Saves active database file in a new file. You can also 
specify a new file format and database will be converted 
to it. 
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2.4.7 Exit  

Exits GalleryData application and closes all currently 
opened database files. 

2.5 Edit menu 
In the Edit menu are collected commands for changing 
and correcting data in the active table. 

Shortcuts to these commands are also available from 
context menu accessible with right click on the field 
value. Multi-select (Ctrl+M) is available from the context 
menu only by pressing the right mouse button when 
positioned in the database field. It allows you to select 
multiple records from the database and delete them all at 
once. This functionality can also be used to copy values 
to another application. 

2.5.1 Cut  

Cuts selection from the active field in the table and places 
the text on the Windows clipboard. 

2.5.2 Copy  

Copies selection from the active field in the table and 
places it on the Windows clipboard. 

2.5.3 Paste  

Paste contents of Windows clipboard into the active field 
in the table. 

2.5.4 Delete 

Delete selection of the active field in the table. 
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2.5.5 Find / Replace 

 
Find/Replace dialog box 

The Find/Replace command is used when searching for 
records in the active table or replacing some field values 
with some other. 

First select in which field you would like to look for (or 
replace) your data, then enter type-in data for Find and 
Replace edit fields. 

If Match case is enabled, GalleryData will distinguish 
between small and capital letters. For example, "Mary" 
will not be interpreted the same as "mary" or "MARY". 
If Exact search is enabled, the entered value in Find edit 
field will have to match the actual value of the database 
field. For example, looking for "Ma" will not find "Mary" 
or "Marusha". 
Click Find to start the search process, click Next to find 
another record complying to search criteria. 
Click Replace to replace the first-found field with 
replacement value. Click Replace All to make replace 
modification to all records that compy to the replace 
criteria. 

2.6 View menu 

2.6.1 View / Edit 

With this command the usage of the active table can be 
changed. You can modify the data in the table only when 
text is in the edit mode. All database values are printed in 
black letters. 



Chapter 2: Reference  
 
 

2-14 GalleryData User's Manual 

If you are using view mode, then the table cannot be 
accessed and nothing can be changed. All database values 
are printed in gray letters. 

The default mode is the edit mode. Shortcut key <F9> 
makes it possible to quickly change between the two 
modes. The left side of the status bar will let you know 
the mode currently being used. Another shortcut for 
selecting the mode is clicking the status bar on this 
location. 

2.6.2 Table/Record 

By choosing this command you can change the current 
display mode on the table. It can be a record view or a 
table view. 

In record view only one record is shown at the same time. 
In table view all records in the table can be observed at 
the same time. 

2.6.3 Toolbox  

Choose this command to hide or display Toolbox. 

The Toolbox is a row of buttons at the top of the main 
window which represent commands for opening, saving 
files, cutting to clipboard, etc. Clicking on one of the 
buttons is a quick alternative to choosing a command 
from the menu. Buttons on the Toolbar are activated and 
deactivated according to the state of the application. 

 

Button Action Menu Equivalent 

 Create a new form File / New 

 Locate and open file File / Open 

 Save file File / Save as 

 Cut to Clipboard Edit / Cut 

 Copy to Clipboard Edit / Copy 

 Paste from Clipboard Edit / Paste  

 Create table report Tools / Report 

 Table/Record view View / Table/Record 

 Help contents Help / Contents  
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 Restructure Options / Restructure 

2.6.4 Text tool  

Choose this command to hide or display Text tool.  

 
Text tool provides shortcuts for changing font properties 
of the text in the active table. 

2.6.5 Navigator tool  

Choose this command to hide or display Navigator tool.  

 
Navigator tool provides shortcuts for navigation in active 
table. 

Button Action 

 Go to first record 

 Go to prior record 

 Go to next record 

 Go to last record 

 Insert a record 

 Delete a record 

 Confirm the changes in a record 

 Cancel the changes in a record 

2.7 Tools menu 

2.7.1 Fill 

Fill the Output table with data from the Input table. 
Output table is automatically created if it doesn't exist. If 
it exists, the output table will be emptied before it will be 
filled with new values. Filling will be interrupted, if field 
types do not match. 
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Fill table dialog box 

Input file record length can be used only when input is 
an ASCII text file. Records with different lengths of that 
set here will be eliminated in the filling process. 

Skip records field defines a number of records that 
should be avoided in the table before filling data. With 
this you can skip the number of records on the beginning 
of the Input table. In most cases this is used to avoid the 
transfer of data header. This function works only, when 
the input table is an ASCII text file. 

With this command you can easy convert existing ASCII 
text file to Paradox or dBase database table. Just select 
input ASCII file and output table with .DB or .DBF 
extension. 

By default this command matches fields based on their 
position in the source and destination tables. That is, the 
first field in the source is matched with the first field in 
the destination, and so on. 

To override the default field mappings, use the Map 
fields button. Map fields dialog box is shown. 

See also: 

 

 

2.7.2 Map fields dialog box 

In this dialog box you can specify, how to link fields 
between input and output table. 
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Map fields dialog box 

This is a list of source and destination table fields. To 
map fields select exactly one field both lists and press 
map button. 

This will override the default setting, where the first field 
in the first table is matched to the first field in the second 
table, second to the second and so on. 

2.7.3 Append 

This function adds data from the Input table to the end 
of the Output table. This command is similar to Fill 
command, except that data in the output table is not 
erased or changed. 

Appending will be interrupted if field types do not match. 

 
Append data to table dialog box 
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Input file record length can be used only when the input 
is a text file. Records of which length won’t suit will be 
eliminated. 
Skip records field defines a number of records that 
should be avoided in the table before filling data. With 
this you can skip the number of records on the beginning 
of the Input table. In most cases this is used to avoid the 
transfer of data header. This function works only, when 
the input table is an ASCII text file. 

By default function matches fields based on their position 
in the source and destination tables. That is, the first field 
in the source is matched with the first field in the 
destination, and so on.  

To override the default field mappings, use the Map 
fields button. Map fields dialog box is shown. 

See also: 

 

 

2.7.4 Update 

Update command is similar to Append - it adds records 
from one table to another. The difference is that if the 
same record already exists in destination table, is it 
updated to match the one in a source table. Records are 
considered equal if they match in their primary indexes. 
Both tables must therefore contain indexes. 

 
Update table dialog box 
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Input file record length can be used only when the input 
is a text file. Records of which length won’t suit will be 
eliminated. 
Skip records field defines a number of records that 
should be avoided in the table before filling data. With 
this you can skip the number of records on the beginning 
of the Input table. In most cases this is used to avoid the 
transfer of data header. This function works only, when 
the input table is an ASCII text file. 

By default function matches fields based on their position 
in the source and destination tables. That is, the first field 
in the source is matched with the first field in the 
destination, and so on.  

To override the default field mappings, use the Map 
fields button. Map fields dialog box is shown. 

See also: 

 

 

2.7.5 Empty 

All data in active table will be erased and lost if you 
choose this command. So be careful when using this 
command. The result will be empty database, only 
database the structure will remain. 

2.7.6 Pack  

When using dBase file format, the data you erase in the 
database is not actually deleted from the database. It is 
only mark as deleted, is not available to applications 
anymore, but is still contained in the file. 

This command will physically delete these deleted 
records from the database and compact the database file. 

2.7.7 Report 

Contents of the current table can be printed to the printer 
or to a tab-separated text file. Tab character will be used 
as a separator to database fields. The primary use of this 
command is the ability to export your database to a plain 
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text file and use it, where the true database file format 
would not be applicable. 

2.7.8 Other SATO Label Gallery TruePro programs 

Here you can also quickly start other applications from 
SATO Label Gallery TruePro. 

Label Gallery Plus 

Starts Label Gallery Plus - program for designing and 
printing labels. 

GalleryForm 
Starts GalleryForm - custom user entry form designer. 

GalleryWatch 

Starts GalleryWatch - a program that can automatically 
trigger label production when certain events occur. 

GalleryMemMaster 
Starts GalleryMemMaster - printer memory card 
manager. 

2.8 Options menu 

2.8.1 Restructure 

Using this command you can change the table’s structure, 
which you want to arrange. Structure arranging is 
described in the Fields tab of the New command. 

2.8.2 Indexes 

Choose this command to select or update indexes on 
active table. 

 
Indexes dialog box 
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Indexes dialog box is used to select active index and 
rebuild already present indexes. 

To select index choose only one item in index list and 
click the Select button. 

To update indexes select at least one item in index list 
and click the Update button. 

If you click on the Modify button, you can modify the 
selected indexes. Dialog box is shown, allowing you to 
modify the indexes in a table. Working with indexes is 
described in Indexes tab of the New command. 

2.8.3 Font 

Choose this command to select the display font for the 
current table. If table is in ASCII, Paradox or dBase 
format, font setting is saved with table and that font is 
automatically used again when the same table is opened 
at another time. 

2.9 Window menu 
In Window menu are window-related commands such as 
Tile and Cascade. 

2.9.1 Cascade  

This command arranges open windows to overlap. Active 
window is on top, others are below. 

2.9.2 Tile 

Command makes visible all open windows without 
overlapping. Space mentioned for particular window is 
proportional to the number of open files. Simultaneously 
can be opened only nine documents. 

2.9.3 Arrange icons 

Arrange window icons at the bottom of the main window. 

2.9.4 Minimize all 

Minimize all open table windows to icons. 
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2.9.5 Close all 

Close all open documents. Program launches a warning, 
if a document change was done. 

2.9.6 List of open tables 

In the list of open documents are enumerated all open 
tables. Active table can be modified by choosing a table 
from the menu. 

2.10 Help 
In Help menu are collected help topics and interactive 
knowledge about GalleryData.  

2.10.1 Contents 

Open a dialog box with list of chapters concerning help. 

2.10.2 Label Gallery on the web 

Open Label Gallery website (www.satoworldwide.com) 
in your current web browser. 

2.10.3 About 

Open a dialog box with the title picture of the program, 
information about the program and its serial number. 

2.10.4 Missing Help Topic 

The Help topic associated with the currently selected 
request is unfortunately not available in on-line help at 
this time. Label Gallery help is in constant process of 
upgrade and the new version of Label Gallery software 
with updated help files might already be available for 
download on the internet. 

Please visit Label Gallery website at 
http://www.satoworldwide.com and verify if the upgrade 
of Label Gallery software is available. 
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3. Miscellaneous 

3.1 Command line commands 
If you want to execute some commands when 
GalleryData starts, you can specify additional command 
line parameters. 

 

Command line parameters are: 

Fill table: 

-F output_table input_table 
[/Saaa][/Tbbb] 
 

Output table is filled with the records from the input 
table. 

/Saaa Optional parameters to check record size where 
aaa is record length. 

/Tbbb Optional parameters to skip records where bbb is 
the number of records you want to skip. 

 

Append table: 
-A output_table input_table 
[/Saaa][/Tbbb] 
 

Records from input table are added to the output table. 

/Saaa Optional parameters to check record size where 
aaa is record length. 

/Tbbb Optional parameters to skip records where bbb is 
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record length. 

 

Append and update table: 
-AU output_table input_table 
[/Saaa][/Tbbb] 
 

Records from input table are added to the output table. If 
the same records already exist in output table, it is 
updated. 

/Saaa Optional parameters to check record size where 
aaa is record length. 

/Tbbb Optional parameters to skip records where bbb is 
record length. 

 

Open table: 

-D table_name or just table_name. 

 

Empty table: 

-E table_name 

 

This command can also be combined with append 
comand (-AE). In this case the table is first emptied, and 
then the records from input table are appended. 

 

Opens table in table view: 

/G 

 

Opens table in record view: 

/L 

 

Quit GalleryData: 

/Q 
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Do not report any errors: 

/E 

 

Example: 
GDATA.EXE -f articles.dbf import.txt 
/q 
This command line converts a text file into dBase table. 
The indexes that may exist in output table are not 
recreated. After it is finished, GalleryData closes. 

 


